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1. Introduction

Chapter 1. Introduction

Manufacturers have defined various useful MIB variables for their devices

that are missing in a standard SNMP Get request. Therefore, Hirschmann
Automation and Control GmbH's HiFusion also allows you to integrate
manufacturer-specific MIB variables from third-party devices into the
Management-Software, Industrial HiVision. For this, you create Product-
Specific Modules (PSM). When creating a PSM, you name the device, define
a range of variables, and assign an image to the device. The execution

of the process is largely automated. If you integrate the finished PSM in
Industrial HiVision, the properties defined by you are available in Industrial
HiVision. HiFusion works as an independent application, regardless of whether
Industrial HiVision is installed. The program works without a license. The only
prerequisite for incorporating non-Hirschmann MIB variables, is that the devices
support version 1 or version 3 of the Simple Network Management Protocol
(SNMP).

In this user manual, you find the following release notes:

* A guide to working with the software
* A description of the program user interface and its functions

« Step-by-step instructions for creating a PSM
The user manual teaches you the following skills:

* Creating your own PSMs

» Adapting existing PSMs

* Testing PSMs

Note: For readability purposes, this documentation uses the classic Windows
view for screen shots.
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2. Installation

Chapter 2. Installation
This chapter describes

» System Requirements on page 7

* Installation under Windows on page 8

* Installation under Linux on page 9

* Maintenance on page 10

* Deinstallation under Windows on page 9

* Deinstallation under Linux on page 10

System Requirements

HiFusion has the following requirements with regard to the hardware and the
operating system of your computer.

Hardware

» x86-compatible processor, 1 GHz or higher
* At least 1 GB of RAM, 2 GB recommended
* Disk space 2 GB free

» Monitor resolution of 1024 x 768 pixels

Operating system

» Windows 8.1 Professional (64 Bit)

Windows 10 Version 1803 (64 Bit)

Generator for Product-Specific Modules (PSM)
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2. Installation

* PC Linux (64 Bit: Kernel 3.10, libc 6)
Debian 8
Debian 9
Debian 10
Red Hat 7
Red Hat 8

Note: Debian Linux: Install the packages libmono2.0-cil and libmono-
winforms2.0-cil.

Installation under Windows

* Open the Hirschmann HiFusion web site:
catalog.belden.com
* Click "Resources".
+ Select the "HiFusion - Windows Version> Download" link.
* Extract the zipped files.
» Navigate to the location of the extracted files.
* Double click the hi f usi on04700_wi ndows. exe file.
» Answer the questions of the installation script and follow its instructions.

If you do not answer a question of the installation script, the installation
script selects the default answer.

Generator for Product-Specific Modules (PSM)
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2. Installation

Installation under Linux

* Open the Hirschmann HiFusion web site:
catalog.belden.com

* Click "Resources".

+ Select the "HiFusion - Linux Version> Download" link.

* Unpack the hi f usi on04700_I i nux. t ar file using the following
command:

tar -xf hifusion04700.tar -C /path/to/directory
« Start the installation script with the command
sh /path/to/directory/linux/install.sh
* Answer the questions of the installation script and follow its instructions.

If you do not answer a question of the installation script, the installation
script selects the default answer.

Deinstallation under Windows

* Quit the HiFusion program before you start the deinstallation.
« To deinstall HiFusion, select Start > Control Panel > Software.
« Select the HiFusion program.

* Click Change/Remove and follow the instructions of the deinstallation
routine.

Generator for Product-Specific Modules (PSM)
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2. Installation

Deinstallation under Linux

+ Quit the HiFusion program before you start the deinstallation.
* Logon with the su command so that you have root access rights.

* Delete the / opt / hi f usi on4. 7 directory with the command rm
-rf /opt/hifusion4.7 .

Maintenance

Hirschmann is continually working on improving and developing their
software. Check regularly whether there is an updated version of the
software that provides you with additional benefits. You find information
and software downloads on the Hirschmann product pages on the Internet
(www.belden.com).

Generator for Product-Specific Modules (PSM)
Release - 05/2026

10


https://www.belden.com

3. Starting the application

Chapter 3. Starting the application
Starting under Windows

To start the program, double-click the program icon on the desktop.
Alternatively, you can find a link to the program in the Start menu and in the
installation directory.

Starting under Linux

* You start the program with the command / opt / hi f usi on4. 7/ bi n/
hi f usi on.

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

Chapter 4. Interface of the program

This chapter describes the program interface of HiFusion. It provides you with
an overview of the buttons to help you find your way through the graphical
interface. At the same time, this chapter explains a number of principles to you
on which the program is based.

After reading this chapter, you will be familiar with the following subjects:

« the interface of the program,
« the buttons and their functions,

» a number of principles on which the program is based.

You control the functions of HiFusion using tabs and menus. The following
chapters describe the tabs and menus and their functions.

Copyright:

Creator:

Vendor:

Software Conditions

Version
PSM Generation: 1.0

Industrial HiVision Version: 08.1.01

Figure 1. Menu bar and tabs of HiFusion .
1 Menu bar
2 Tabs

Menu bar

HiFusion has a menu bar with multiple menus. You use the menu bar to
control the functions of the program.

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

The following menus are available to you:

* File on page 13

* PSM on page 14

» Language on page 16

* Tools on page 17

* Help on page 18

FR S Cinguage ool e

[T MBs  Device
Name:

Label:

Desarption:

Copyright:

Creator:

Vendor:

Software Conditions:

Version:
PSM Generation:

Industrial Hivision Version:

Figure 2.

File

PortGeneration  Properfies  Traps  Transiatins  MultiConfi
The intermal name of the PSM

The vishle name of the PSM, A transiation should be provided for this field,
The description of the PSM

The copyright notice of the PSM

The name of the author of the PSM

The name of the vendor of the PSM

The version of the PSM consists of at least 3 digits.
10

08.1.01

Save preset

Menu bar

Load preset

When you have several PSMs to create, the File menu allows you to create
new PSMs without restarting the HiFusion program. Furthermore, the menu
also allows you to open previously saved PSMs projects.

The following buttons are available to you in the File menu:

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

* New PSM

This button allows you to start creating a new PSM without restarting
the HiFusion program.

* Open

Using this button allows you to browse to the location an existing PSM
project saved during a previous session and open the PSM project.

- Save

You save an ongoing PSM/PSM project. The first time you save the
file HiFusion opens a browsing window allowing you to save the file in
a selected location. You save subsequent changes to this file. The file
is saved as a zip file.

» Save as...

You save an ongoing PSM/PSM project in a selected location. The file
is saved as a zip file. It is strongly recommended that the file name
remain the same as it is displayed in the dialog. The digits at the end
of the file name are the digits you entered as the PSM version number.

* Exit
You exit the HiFusion PSM Generator, any unsaved work is lost.

When you click Exit the application exits without confirmation only if
there are no changes.

If you open and modify a PSM and you click Exit, a popup dialog
opens allowing you to select save changes, discard or cancel.

PSM

The PSM menu contains options that allow you to verify that the PSM you
created, functions properly.

The following buttons are available to you in PSM menu:

Generator for Product-Specific Modules (PSM) 14
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4. Interface of the program

¢ Check PSM

Checks whether the created PSM is plausible. HiFusion checks, for
example, whether you have filled in the relevant fields.

When HiFusion detects an error in the PSM, then the program
displays the Errors and Warnings dialog describing the severity,
reason and location for the detected error.

After you correct and recheck the detected errors, HiFusion displays a
message window informing you that the PSM is ready for testing.

* Test PSM...

Opens the Test PSM dialog containing the following radio buttons
used for testing your PSM in different environments:

o Virtual device

HiFusion includes a built-in test environment. This means that
you can test your PSM without using Industrial HiVision. If you
use Industrial HiVision to test your PSM save the Industrial
HiVision configuration.

The option, Internal agent uses the MIB dump created in the
current PSM project.

If you have a MIB dump of a device from the same family, then
you can also test the file by selecting the file in the Custom
agent dump file field.

o

IP of real device

In the text field, specify the IP address of a device which
uses the same MIBs as contained in your PSM project. After
creating the PSM you can test the PSM with a real device. If
you changing the values in the device, then the values in the
table change after a Rescan. The Kernel dialog contains the
Rescan button.

° The dialog contains the following buttons:

Test

Generator for Product-Specific Modules (PSM)
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4. Interface of the program
Application generates a virtual PSM, then opens the Kernel
dialog allowing you to view the parameters and their values.

When testing the PSM using the virtual agent, HiFusion reads
the values that are present in PSM dump file.

When testing the PSM using a real device, HiFusion reads the
values of the device.

Close
Exits the Test PSM window.
* Generate PSM...

Opens the Generator Settings dialog, allowing you to save the PSM
project and generate the PSM. It is strongly recommended that you do
not change the file name. The digits at the end of the file name are the
digits you entered as the PSM version number.

The dialog contains the following fields:
- Save PSM project

Checkbox marked, saves the PSM project and generates the
PSM.

The text field allows you to specify the desired location for your
PSM zip file.

Checkbox unmarked, only generates the PSM.
o PSM Location

The text field allows you to specify the desired location for your
PSM file. The extension of the PSM is i hvpsm

Language

HiFusion allows you to set the interface dialog to several different languages.
Select the language that best suites you from the menu.

The following languages are available:

Generator for Product-Specific Modules (PSM)
Release - 05/2026

16



4. Interface of the program

* English

« Italian

* Korean

* Portuguese
* Greek

* Indonesian
» Spanish

* French

» Japanese
* German

* Russian

* Chinese

Tools

The menu allows you to view the values of MIB variables available on device.

The following list describes the available options:

Generator for Product-Specific Modules (PSM)
Release - 05/2026
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4. Interface of the program

« MIB Viewer

The menu item opens the MIB variable selector dialog allowing you to
verify the MIBs that you entered into the PSM project. The MIB Viewer
has a copy and paste function making it possible to copy any cell in
the dialog, and then paste that information into a planning tool.

- Search

The text field allows you to search through the table for a
specific MIB variable.

> The table lists the MIB information in the following columns:
MIB variable name, identifies the name of the MIB object.
Value, the value of the variable.
Type, lists the MIB object type.

Description, the description of the MIB variable as defined in
the MIB.

MIB, displays the name of the MIB.
* Update dump

The menu item opens a browser allowing you to navigate to an

existing dump file saved during a previous session. After a firmware
update, new OIDs are available for the device. Updating an existing
dump file allows you to include the new OIDs in an existing project.

Help

The following menu items are available to you in the Help menu:

Generator for Product-Specific Modules (PSM)
Release - 05/2026
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4. Interface of the program

* Online Help

Opens the online help menu allowing you to search through the
various subjects.

» Belden Website
Opens your browser and navigates to the Belden website.
* About

Opens a text window which displays the latest program information for
example, the release level.

Tabs

The tabs allow you to view and change the various properties in the PSM
project.

The following tabs are available to you:

* PSM on page 20

* MIBs on page 22

* Device on page 22

* Port Generation on page 24
* Properties on page 31

* Traps on page 36

* Translations on page 36

* MultiConfig™ on page 37

* Changelog on page 37

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

> (diconts

provided for this field.

Figure 3. Tabs

PSM

The PSM tab contains basic parameters of your PSM. You define the
parameters when you create a PSM. Industrial HiVision displays some of the
parameters after importing the PSM into the program.

The parameters contained in the tab include:

* Name

Specify the name of the new PSM. When specifying the name of
the PSM either write the words together, or use an underscore _
for separation. Furthermore, when creating the name, the same

characters restrictions apply as when you name a folder in a directory.

« Label

Specify the PSM name which Industrial HiVision displays.

* Description

The description allows your to readily identify the PSM.

» Copyright

Generator for Product-Specific Modules (PSM)
Release - 05/2026
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4. Interface of the program

To maintain the copyright of your PSM, specify the legal or natural
person who owns the copyright. The copyright is a composition of the
manufacturer name and the current year.

* Creator
Specify the author of the PSM.
* Vendor

The manufacturer of the device for which the author generated the
PSM. The program does not allow Hirschmann to be identified as the
manufacturer. Industrial HiVision displays this parameter.

» Software Conditions

Specify the conditions under which other people are allowed to use
the PSM.

* Version

Specifies the version number of the PSM. Enter a three digit number,
without a point . . Industrial HiVision adds the point automatically. For
example, Industrial HiVision displays 100 as 1. 00. Use the version
number to keep track of each edition of your PSM. To maintain an
overview of your PSMs, create a list containing the appropriate
information regarding your PSMs.

Industrial HiVision displays this parameter.
» The PSM tab contains the following buttons:
o Save preset

Opens a browser allowing you to save the information entered
in the Load preset tab in a location of your chose. Extension of
this file is hud (Industrial HiVision User Data).

o Load Preset

Opens a browser allowing you to navigate to a . hud file and
populate the PSM tab with information saved in the . hud file.

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

MIBs

The Management Information Base (MIB) describes the information that the
network management protocol reads via an SNMP Get request. MIBs have a
tree structure. The tree structure consists of two areas: a standardized area
and a manufacturer-specific private area (private MIB). In the private MIBs,
manufacturers create separate MIB branches with manufacturer-specific
properties.

Note: Every manufacturer sets up their own private MIB(s) and defines
their own variables and tree structures. Manufacturers make the MIB(s)
that relate to their devices for example, as a download on their devices
or via the manufacturer website. Save the manufacturer-specific MIB(s)
locally when creating a PSM for a device from this manufacturer.

The tab contains the following items:

* MIB Table
The table displays the MIBs loaded in the PSM project.
* Buttons
> Add

Opens the Choose MIBs dialog allowing you to navigate to the
location where you saved a MIB which you load into the PSM
project for example, a manufacturer-specific MIB.

> Remove

Removes the selected MIB from the PSM project.

Device

Industrial HiVision displays the values specified in the tab allowing you to
identify the device.

The dialog contains the following frames:

Generator for Product-Specific Modules (PSM)
Release - 05/2026
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4. Interface of the program

* Identification and Images

Specifies the device

o Table
Sys OID

Displays the system object identifier of the MIB object.
Industrial HiVision uses the parameter to identify the device
type if no additional device identification is present.

Product Name

Specifies the name of the device which Industrial HiVision
displays. HiFusion retrieves the product name directly from the
device.

Image

Displays the image of the device which Industrial HiVision
displays.

Additional device identification

Displays addition information used to identify the device. Using
the Edit button you specify the parameter. You can use the wild
card character * in the identifier.

Vendor Name

Specifies the name of the device manufacture. When you
specify the vendor name, Industrial HiVision displays the value.

> The Edit button opens the Device identification dialog,
allowing you to specify individual device parameters displayed
in the Identification and Images table.

* SNMP Access Params

The frame displays the detected communication protocols and

the SNMP access parameters. Industrial HiVision displays these
passwords as clear text in the Preferences > Advanced > Device
Credentials dialog. To avoid a possible security risk, change the
access parameters to the default settings

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

Note: HiFusion stores these parameters in the generated PSM.
Enter only the default passwords of the device.
* Protocols

Specifies the communication protocols and the SNMP access
parameters:

o Management protocols

Industrial HiVision adds the management protocols to the
Protocols frame.

o Supported protocols

Industrial HiVision uses the support protocols for enabling
menu entries like CLI and GUI Interfaces for the device.

Port Generation

You use the Port Generation function to map the ports and modules. When
you make a PSM for non-modular devices, use the PSM only on the non-
modular devices of the same type. When you make a PSM for modular
devices, use the PSM only on modular devices of the same type.

Note: This function is compatible with Industrial HiVision starting with
release 08.1.01.

Default Port Generation

When you select the Default Port Generation radio button, HiFusion
generates 1 port per interface. (Default setting).

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

Custom Port Generation

» Set ifName as Port instance:

Content of the variable i f Nane is used as port instance.

Note: This function is compatible with Industrial HiVision starting
with release 08.7.00.

« Add Port property Description:

Adds the port property Add Port property Description.

Note: This function is compatible with Industrial HiVision starting
with release 08.7.00.

Non-Modular Devices

You use the Custom Port Generation function to map device ports. For
example, when your device has 6 physical ports and other interfaces. You
limit the number of ports that HiFusion maps. HiFusion thus, ignores the
internal interfaces.

Instance (iflndex) |ifindex |ifDescr ifType ifMu  |ifSpeed ifPhysAddress ifAdminStatus  |ifOperStatus
1 1 Vian1 propvirtual (53) 1500 34c0:5:0R92:c0_|up (1) lup (1)
10] 10 Vian10 propvirtual (53) 1500 34c0:R:0R52el|up (1) ldown (2
1] 11 Vian1l propvirtual (53) 1500 34c0::0R92c2_|up (1) ldown (2)
10001 10001 [astEthernetl/l  |ethernetCsmacd (5) |1500 34:c0:5:0R:52:83_|up (1) lup (1)
10002] 10002 [FastEthernetl/2  |ethernetCsmacd (5) 1500 |10000000 lup (D) ldown (2)
10003 10003 [FastEthernetl/3  |ethernetCsmacd (5) 1500  |10000000 lup () down (2)
10004] 10004  [FastEthernetl/4  |ethernetCsmacd (5) 1500  [10000000 lup (1) down (2)
10277] 10277 bitEthernet1/1 |ethernetCsmacd (6) [1500  [10000000  [34c0:f9:0f:92:81 |up (1) down (2)
10278 10278 bitEthernetl/2 |ethernetCsmacd (6) [1500  [10000000  [34c0:f9:0f:92:82 |up (1) down (2)
10501 10501 MUl other (1) 1500 4294967295 lup () lup (1)

Figure 4. ifTable of a non-modular device with 6 physical
ports

Generator for Product-Specific Modules (PSM)
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4. Interface of the program

« To configure the ports, select the Custom Port Generation radio
button.

* The Lowest ifiIndex field sets the lowest interface index number for
which a port should be created. To activate the Lowest ifindex field,
mark the Lowest ifindex checkbox.

Note: This function is compatible with Industrial HiVision starting
with release 08.7.00.

* In the Lowest ifIndex field, enter the value 10001.

» The Highest ifIndex field sets the highest interface index number for
which a port should be created. To activate the Highest ifiIndex field,
mark the Highest ifIndex checkbox.

* In the Highest ifindex field, enter 10500.

File PSM Language Tools Help
PSM  MBs Device PortGeneraton  propertes Traps Transktins  MuliConfig™  Changelog

O Default Port Generation
© Custom Port Generation
(0 setifiiame as Port instance

(D) Add Port property Description

Lowest findex; 10001
Hghestifindex: | 10500]
Ports per Module: |0

() Mappingifindex -Port:

ifindex Moduie Number PortNumber

Figure 5. Port Generation > Highest ifindex

If you have unordered physical ports as seen in ifTable of a non-modular
device with 2 unordered physical ports on page 27, then Industrial

HiVision displays the ports as port 2 and 3. To have Industrial HiVision
display the ports as 1 and 2, you map the ports using the Mapping ifindex -
Port function. In this example, you map et h1 to port 1 and et ho to port 2.

Generator for Product-Specific Modules (PSM)
Release - 05/2026

26



4. Interface of the program

Instance (ifindex) |ifindex|ifDescr |ifType ifMu  |ifSpeed ifPhysAddress ifAdminStatus |ifOperStatus
1 1 lo softwareloopback (24) 16436 (10000000 up (1) up (1)

2] 2 ethd ethernetCsmacd (5) 1500 [0 00:80:63:6b:a3:e8 |up (1) down (2}

3 3 ethl ethernetCsmacd (8) 1500 100000000 |00:80:63:6b:a3:e9  |up (1) up (1)

4] 4 ipsecO  [tunnel (131) o 1] down (2) down (2)

5 5 ipsecl  |tunnel (131) o 1] down (2) down (2)

3 5 ipsec2  |tunnel (131) o 1] down (2) down (2)

7 7 ipsec3d  |tunnel (131) 0] ] down (2) down (2)

B 8 bri ethernetCsmacd (8) 1500 10000000  |00:80:63:6b:a3:e8  |up (1) up (1)

Figure 6. ifTable of a non-modular device with 2 unordered
physical ports

« To configure the ports, select the Custom Port Generation radio
button.

* To map the physical ports, mark the Mapping ifindex - Port
checkbox.

+ To add port 2 to the mapping table, click the Add button. HiFusion
opens the Add Port Mapping dialog.

« To configure instance 2 (et h0), enter 2 in the ifiIndex field.
» To map instance 2 to port 2, enter 2 in the Port Number field.

* In the Add Port Mapping dialog, click the Add button. HiFusion adds
the information to the table.

+ To add another port to the table, click the Add button again.

Note: Each time you click the Add button to open the Add Port
Mapping dialog the number in the iflndex and Port Number fields
increase by 1.

* To configure instance 3 (et h1), verify that the ifindex field contains
the number 3.

» To map instance 3 to port 1, enter 1 in the Port Number field.

* In the Add Port Mapping dialog, click the Add button.
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File PSM Language Tools Help |
PSM  MB: Devie PortGenerafon propertes Traps  Transiatons  MuliConfig™ |
O Default Port Generation
O Custom Port Generation
Setifiame as Port instance
Add Fort property Description
(0 Generate Modules
© Using the ifrable
Lowestifindex: [0
Highestifindex: [0
Ports per Module: [0

Q Mappingifindex - Port

ifindex Module Number Port Number = |
2 9 9
3 il 3| Addvoduie
Edt
Delete

Figure 7. Port Generation > Mapping ifindex - Port

Modular Devices

You can configure a modular device that has the same number of physical
ports on each module. The example device has 7 modules with 4 ports
each. Other internal interfaces are present in the device, such as the CPU
interface. You only map the 28 physical ports.

Instance (findex) ifindex ifbesc ifType iMtu |ifSpeed ifPhysAddress ifadminstatus|ifoperStatus
1 1 Module: 1Fort: 1- 1 Gbit [ethernetCmacd 1500 [0 00: up (1) down (2)
2] H Module: 1Fort: 2 - 1 Gbit [ethermetCemacd 1500 [0 o up (1) down (2)

3 3 Module: 1Fort: 3 - 1 Gbit [ethermetCemacd 1500 [0 o up (1) down (2)
4 4 Module: 1Fort: 4- 1 Gbit [ethermetCemacd 1500 [0 00:80:63:58:2b:00|up (1) down (2)

5 5 Module: 2Port: 1- 10/100 Mbit TX|ethernetCsmacd 1500 [0 00:80:63:58:2b:0¢|up (1) down (2)

B 5 Module: 2Port: 2- 10/100 Mbit TX_|ethernetCsmacd 1500 [0 up (1) down (2)
7] 7 Module: 2Port: 3- 10/100 Mbit TX_|ethernetCsmacd 1500 [0 up (1) down (2)

B 8 Module: 2Port: 4- 10/100 Mbit TX_|ethernetCsmacd 1500 [0 up (1) down (2)

B s Module: 3Port: 1- 10/100 Mbit TX|ethernetCsmacd 1500 [0 up (1) notPresent
10] 10 |Module: 3Port: 2- 10/100Mbit TX  |ethemetCsmacd 1500 [0 up (1) notPresent
11] 11 |Module: 3Port: 3- 10/100Mbit TX  |ethemetCsmacd 1500 [0 up (1) notPresent
1] 12 |Module: 3Port: 4- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) notPresent
13] 13 |Module: 4Port: 1- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) down (2)
14 14 |Module: 4Port: 2- 10/100Mbit TX |ethemetCsmacd 1500 |100000000 up (1) up (1)

15] 15 |Module: 4Port: 3- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) down (2)
16] 16 |Module: 4Port: 4- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) down (2)
17] 17 |Module: SPort: 1- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) notPresent
18] 18 |Module: SPort: 2- 10/100Mbit TX  |ethemetCsmacd 1500 [0 up (1) notPresent
19] 19 |Module: SPort: 3- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) notPresent
20] 20 Module: SPort: 4- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) notPresent
21] 21 Module: 6Port: 1- 10/100Mbit TX  |ethemetCsmacd 1500 [0 up (1) down (2)
23] 22 Module: 6Port: 2- 10/100 MBIt TX  |ethemetCsmacd 1500 [0 00:80:63:58:2b:1d|up (1) down (2)
23] 23 Module: 6Port: 3- 10/100MBit TX  |ethemetCsmacd 1500 [0 00:80:63:58:2b: 1 |up (1) down (2)
24] 24 Module: 6 Port: 4- 10/100Mbit TX |ethemetCsmacd 1500 [0 up (1) down (2)
25] 25 Module: 7Port: 1- 10/100Mbit TX  |ethemetCsmacd 1500 [0 up (1) down (2)
26] 26 Module: 7Port: 2- 10/100 MBIt TX  |ethemetCsmacd 1500 |100000000 up (1) up (1)

27] 27 Module: 7Port: 3- 10/100Mbit TX |ethemetCsmacd 1500 [0 00:80:63:58:20:22|up (1) down (2)
25] 28 Module: 7Port: 4- 10/100MBit TX |ethemetCsmacd 1500 [0 00:80:63:52:20:23|up (1) down (2)
53] 33 |CPUInterface for Module: 10Port: 1 [other (1) 1500 [0 00:80:63:58:20:00 |up (1) up (1)

Figure 8. ifTable of a modular device with 28 physical
ports

Generator for Product-Specific Modules (PSM)
Release - 05/2026



4. Interface of the program

« To configure the ports, select the Custom Port Generation radio
button.

* To activate the Highest ifindex field, mark the Highest ifindex
checkbox.

* In the Highest ifindex field, enter 28 as the maximum number of
physical ports on your device.

« To configure the modules, select the Generate Modules checkbox.

« To set the number of ports per module, mark the Ports per Module
checkbox.

* In the Ports per Module field, enter 4 as the number of physical
ports on each module.

File PSM_Language Tools Help |
PSM  MBs Devie PortGenerafon  properties Traps Transiatons  MuliConfig™ |

O Default Port Generation
O Custom Port Generation
Setifiame as Port instance
Add Port property Description
Generate Moduies
© Using the iPTable
Lowest findex:
vighestifindex: |28
Parts per Module: 4

(O Mapping findex -Port.

ifindex Modue Number PortNumber

Figure 9. Port Generation > Generate Modules / Ports per
Module

You can also use the Port Generation function for unique modular devices
with a different number of ports per module. In this example, you configure
port mapping for a device with 2 modules. The first module contains 16 ports
and the second module contains 8 ports. The main device contains the first
4 ports.
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Figure 10. ifTable of a modular device without the same
number of port per module

* To configure the ports, select the Custom Port Generation radio
button.

« To configure the modules, select the Generate Modules checkbox.

» To map the physical ports, select the Mapping iflndex - Port
checkbox.

« To add instance 5 to the mapping table, click the Add button.

+ To configure instance 5, enter 5 in the ifindex field.

» To map instance 5 to module 1, enter 1 in the Module Number field.
» To map instance 5 to port 1, enter 1 in the Port Number field.

* In the Add Port Mapping dialog, click the Add button.

+ To add another port to the table, click the Add button again.

* Continue to add the other ports on module 1.

» To add module 2 to the table, click the Add Module button.

Note: Each time you click the Add Module button to open the
Add Port Mapping dialog the number in the iflndex and Module
Number fields increase by 1. HiFusion enters the number 1 in the
Port Number field.

« To configure instance 21, enter 21 in the ifindex field.
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» To map instance 21 to module 2, verify that the Module Number field
contains the number 2.

 To map instance 21 to port 1, verify that the Port Number field
contains the number 1.

* In the Add Port Mapping dialog, click the Add button.
 Continue to add the other ports on module 2.

File PSM Language Tools Help
PSM  MBs Device PortGeneraon  Propertes Traps Translatons  MulfiConfig™  Changelog

O Default Port Generation
O Custom Port Generation
(0 setifiiame as ort instance
(] Add Prt property Description
8 Generate Modules
Q) Using the ifTable
Lowestifindex: [0
vighestifindex: [0
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Figure 11. Port Generation > Generate Modules / Mapping
ifindex - Port

Properties
After a device request, you will see the supported device parameters.

The tab allows you to edit the following areas:
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* Device tree

* Features

* Property type

* Mapping

* Advanced settings

You activate the Advanced settings fields by marking the checkbox.

Device tree

In the Device tree area of the Properties tab, you create new and remove
properties in your PSM.

Right clicking on an item displays a menu allowing you perform the following
tasks:

* New property, add a property to the device.
* Remove, delete a property from the device.
* Expand all, displays the complete list of properties on a device.

* Collapse all, hides every device property except the first sub-level.

Features

The Features frame in the Properties tab contains the features supported
by your device. You only change the supported features if you know that
your device has a property that Industrial HiVision has detected incorrectly.

Property type

In the Property type area on the Properties tab, you define the following:
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« Name

You specify an internal name for the property. HiFusion displays the
translation of the associated token in the Device tree.

* Token

Specifies the device token associated with the property. You can
change the token description in the Translations tab.

* Image
The text field displays the image assign to the property.

The Select button allows you to navigate to an image and assign the
image to the property.

* MIB Variable
The test field displays the MIB variable assign to the property.

The Select button opens the MIB selector dialog allowing you to
select an MIB object and assign the object to the property.

* Instance
o Fixed assignment: You enter a fixed value.

o Variable: From the drop-down list, you select a variable from
which HiFusion contains the instance.

» Data type
o String
A text value for example, system name.
° Integer
A whole number.
° Float
A decimal number for example, 1.6.
° Enum
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The value allows you to map the outcome of an operation into
a meaningful answer for example, 0=No Error, 1=Error.

> MAC Address
Specifies the data type as a MAC address.
o |P Address

Specifies the data type as an IP address.

Note: The selection in the Data type field restricts or expands your
options for the following input fields on the Properties tab. HiFusion
proposes a data type for the selection of an MIB variable. You only
change the data type if you know that the variable has another data type.

Mapping

The Mapping frame gives you the following options:

» Map a received value to the displayed value:

The MIB variable contains a selection of possible (numeric) values
that cannot be interpreted in pure form. During the mapping, you
assign various interpretable statuses to the various numeric values.
Only the Enum data type enables a mapping to be created.

 Convert figures using factor and offset:

The MIB variable supplies figures in a specific format, but you require
the figures in a different format. Only the Integer and Float data
types allow you to convert the figures. The program uses the linear
equation (y = a x x + b) for the calculations. Here a is the factor, b the
offset, x the value in the agent, and y the value in HiFusion.

Advanced settings

The Advanced settings frame allows you to specify how Industrial HiVision
monitors and displays the PSM.

Generator for Product-Specific Modules (PSM)
Release - 05/2026

34



4. Interface of the program
When you mark the Advanced settings checkbox, the functions in the
frame are read-write.
The frame has the following buttons and checkboxes:
* Visible
Specifies whether a property is visible.
* Variable

Specifies whether you can change the way Industrial HiVision
handles a property.

When you select the Variable checkbox, HiFusion allows you to
change the Change after trap, Default polling interval, Status
configuration and Calc status by default functions.

* Change after trap

Specifies whether you have the option to select the property and
update it using traps on the Traps tab.

* Default polling interval

Specifies whether a property activates its polling after Industrial
HiVision discovers a device, and at what interval.

Values have the following meanings:
° Value = 0: off
° Values > 0: interval in seconds
« Status configuration

Specifies whether you create a status configuration. Only variable
properties have a status configuration.

* Calc status by default

Specifies whether a property calculates its status. To calculate the
status, the property requires a status configuration.
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* Writable

If the property is writable, then the property dialog in Industrial
HiVision enables the Write button. The user can set the MIB variable
on the device.

* Bubble help propagation

Specifies the number of levels on which Industrial HiVision
propagates the value of this property. The more levels you enter
here, the earlier you see the value in the bubble help.

Traps

The Traps tab displays the traps that HiFusion found in the MIBs after a
successful upload.

If you know the connection between an MIB variable and a trap, this tab
allows you to change the value of the properties using traps.

HiFusion allows you to change traps that you set Change after trap as
active in the Advanced settings in the Properties tab.

* Monitor the trap that is important for your MIB variable.

Note: As an advanced user, you disable the superfluous standard error
messages.

Translations

HiFusion adds the English explanatory text defined in the MIB to the traps
found. The Translations tab displays the explanatory text when after you
queried the device. HiFusion allows you to translate or modify the English
explanatory text and save the translation. The PSM then contains the
translation. HiFusion also allows you to translate the properties defined by
you. You have the option of translating both the designation of the property
and the values.
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MultiConfig™

The MultiConfig™ tab enables you to configure your PSM for MultiConfig™
dialogs of third party devices and ports. HiFusion displays the MultiConfig™
tab only for PSMs compatible with Industrial HiVision release 08.0.00 or
above.

The MultiConfig™ function allows you to perform the following tasks:

* New property, create a new property for the device or port.
* Remove, delete a property from the device or port.

« Edit image, to edit the icon image of a property.

* Import from PSM, import properties from another PSM.

» Expand, displays the complete list of properties Collapse, hides every
device property except the first sub-level.

Changelog

The Changelog tab allows you to save information on the status of your
PSM development in the PSM project.HiFusion only displays the Changelog
tab for PSMs that are compatible with HiFusion from release 08.6.00.

The text is saved in the PSM project (zip file). The text is not saved in the
generated PSM (ihvpsm file) and is not visible in HiFusion.
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Chapter 5. Creating a PSM

Hirschmann protects the PSMs delivered in Industrial HiVision by default.
Industrial HiVision lists the PSM, depending on the manufacture, as Trusted.
Furthermore, Industrial HiVision prohibits you from overwriting the PSMs from
the manufacture with PSMs you create yourself. You can, however, create
PSMs for devices without PSMs and import them into Industrial HiVision.

Creating a simple PSM is fairly easy, but to develop a more complex PSM
requires knowledge of the following subjects:

 The Simple Network Management Protocol (SNMP),
» the structure of Management Information Bases (MIB) in general,

« the structure of the manufacturer-specific MIB from which you
incorporate manufacturer-specific variables into your PSM.

This chapter gives you step-by-step instructions for creating a PSM. Before
you import a PSM into your operational Industrial HiVision system, save the
Industrial HiVision project file. You can do this under the menu File > Save as
in Industrial HiVision.

Note: If you cannot import a MIB into HiFusion, then validate the MIB at
www.ibr.cs.tu-bs.de/projects/libsmi/tools. If HiFusion detects errors in the
MIB, then contact the vendor for an updated version.

This main chapter contains the following sub-chapters:

* New PSM wizard on page 39

* Define basic parameters on page 44
» SysOID and image on page 45

* Define properties on page 48

» Save a PSM project on page 56
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* Create translations (optional) on page 57
* Check and test the PSM on page 58
» Change an existing PSM on page 63

* Make MultiConfig™ dialogs for PSMs on page 63

New PSM wizard

HiFusion provides you with a wizard to help create a PSM. When you start the
HiFusion program you have the option of starting the wizard or opening an
existing PSM. The wizard allows you to create a PSM by retrieving the MIB
variables values form a dump or from a device. Advanced users can create

a PSM from scratch, defining every MIB variable included in the PSM, but
uploading a dump file into the wizard greatly simplifies the task.

This chapter describes the work steps used when creating a PSM with the
New PSM wizard:

« Start the New PSM wizard and load the device MIB(s).
* Manage the SNMP access parameters.
* Enter the IP address.

» Perform the device request.

Start the New PSM wizard

The wizard allows you to extract the dump file and MIBs variables directly
from a device. The extracted file, dump file, can be helpful when creating
PSMs for devices of the same family. When a device is unavailable, before
you begin, obtain the manufacturer-specific MIB(s) variables from a suitable,
official source then save the MIB(s) locally.

To create a new PSM, perform the following work steps:
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« Start the HiFusion program. After the program starts, the following
options are available:
o Create a new PSM
> Open an existing PSM
° HiFusion
* Open the New PSM wizard, click Create a new PSM.

HiFusion opens the New PSM Wizard dialog. The dialog allows you to
specify the following parameters:

o Industrial HiVision

Specifies the Industrial HiVision start version for which the PSM
is being created.

o IP address

Specifies an |IP address of a device available for MIB and
Dump file extraction. After HiFusion completes the extraction
HiFusion loads the device parameters in your PSM project and
the wizard closes.

o Dump file

Specifies the location of the device dump file, in xml format,
obtained from the manufacture.

o Private MIBs

Displays the manufacturer-specific MIB(s) and location of the
MIB file saved previously.

o SNMP Access Parameters
The dialog allows you to specify the SNMP login parameters.

To activate the Encryption frame, select V3 from the SNMP
Version drop-down list. You can select either No Encryption,
DES, AES128 or AES256C encryption.
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* When you extract the MIB variables from a device HiFusion loads
the MIBs variables directly into your PSM project. To load the
manufacturer-specific MIB(s) in the New PSM wizard, proceed as
follows:

o Click Add

HiFusion opens the Choose MIBs window allowing you to
navigate to the location of the manufacturer-specific MIB(s) that
saved previously.

o Select the MIB(s) to enter in your project by either double
clicking on the file, or highlighting the file(s) then clicking Open.

HiFusion closes the wizard and opens the Device tab.
Note: A MIB may possibly have dependencies on other MIBs. HiFusion
tries to resolve these dependencies itself by looking for the required MIB(s)
in the same directory. If HiFusion does not find the MIB(s) causing the

dependency, HiFusion outputs an error message with the name of the
MIB(s). To resolve the error displayed, you make the MIB(s) available.

SNMP access parameter management

The wizard allows you to change the SNMP access parameters if necessary.

The frame allows you to manage SNMP parameters as follows:

» add new SNMP parameters,
+ edit existing SNMP parameters,

* delete existing SNMP parameters.

To add a new set of SNMP access parameters, you perform the following
steps:
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* Click Add.
The Add SNMP Credentials dialog opens.
» Enter the user name or the password, or both.
* Click Add.
HiFusion deletes the entry from the table.
Note: For SNMPv3 you require a user name and a password. For

SNMPv1, leave the user name text field blank and enter the community
name in the password field.

To edit an existing set of SNMP parameters, you perform the following steps:

* Select the entry to be edited.
HiFusion highlights the row in blue.
* Click Edit
» Change the user name or the password, or both.
* Click OK.

HiFusion shows the changed SNMP access parameters in a table.

To delete an existing set of SNMP parameters, you perform the following
steps:

+ Select the entry.
HiFusion highlights the row in blue.
* Click Delete

HiFusion deletes the set of SNMP parameters from the table.
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Enter the IP address

For the PSM new wizard of HiFusion to identify your device, the PSM new
wizard requires the IP address of the device.

 Enter the IP address (v4) of your device.
* Click Next.

After you click Next, HiFusion opens the Testing device reachability
window. HiFusion checks the reachability and the supported protocols
of the device.

After the check, HiFusion opens the SNMP Parameters dialog with
the discovered SNMP parameters.

Note: HiFusion allows you to change the SNMP parameters. Change the
SNMP parameters only if you are very familiar with the device and know
that the device has SNMP parameters different from the parameters that
HiFusion discovered.

Perform the device request
To now request the device information, you perform the following step:

* Click Finish

HiFusion opens the Perform request window.

Note: Requesting the device information can take several minutes. In
some cases, an agent has 40,000 values or more.

When you have carried out the steps described in this chapter and have
performed a successful request, HiFusion displays the following information:
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* PSM tab, displays the creation, edition, and identification parameters.
* Device tab, displays the detected device and the associated SysOID.
* Properties tab, displays the detected device properties.

« Traps tab, displays the detected traps.

* Translations tab, displays the English descriptions of the traps.

Define basic parameters

This chapter describes how to define basic parameters of your PSM, for
example, the name of the device. The PSM tab contains the basic parameters
referred to in this chapter.

You have carried out the steps described in the previous chapter.

To define basic parameters of your PSM, you proceed as follows:

* Open the PSM tab.
* Specify the internal name of the PSM.
* Enter the visible name of the PSM.
* Enter the description of the PSM.
« Enter the copyright of the PSM.
* Enter the author name of the PSM.
* Enter the manufacturer name.
* Enter the version of the PSM.
Note: If you have forgotten a parameter in a mandatory field, HiFusion

reminds you of the empty field when you use the Check PSM or Test PSM
function.
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SysOID and image

After HiFusion loads the MIB variable values of a device, the System Object
Identification (SysOID) of this device is shown here. You can change the
SysOID and the device icon (image) in the Device tab. Changing the SysOID
allows you to create PSMs for entire device groups.

HiFusion allows you to change the SysOID. Delete numbers from the existing
SysOID allows you to create device groups.

If the SysOID you have entered ends with a point, this entry is valid for the

devices whose SysOID begins with the value in front of the point for example:

*» SysOID of device family: 1.3.6. ... .10
* Device A: 1.3.6. ... .10.2
* Device B: 1.3.6. ... .10.3
* Device C: 1.3.6. ... .11.5

* Devices A and B are within the range of the PSM, and device C is
outside of the range.

Add a SysOID and image to the PSM

HiFusion allows you to add a SysOID and an image. When you select

a representative image for every device family of a manufacturer, this
increases the recognizability in Industrial HiVision. The images in HiFusion
have the dimensions 64 px x 64 px. When you install HiFusion, numerous
icons are available to you in various categories.

To add a SysOID and an image, you proceed as follows:
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* Open the Device tab.

The tab displays the product name, the SysOID, the SNMP access
parameters, the management protocols, and supported protocols of
your device.

* Click Add.

HiFusion opens the Device identification window.
+ Enter the SysOID and the product name.
* Click Select.

HiFusion opens the Select window.

+ Navigate to the image of your choose. To enlarge the image, click on
it.

* Highlight the image.
* Click Select.

HiFusion now displays the image in the Device identification dialog.
* Click OK.

HiFusion displays the changes in the table of the Device tab.

Note: Assign an image to the SysOID(s).

Changing the SysOID and image

When you select a representative image for every device family of a
manufacturer, this increases the recognizability in HiFusion. Images in
HiFusion have the dimensions 36 px x 36 px.

If you have not assigned an image to the SysOID(s) so far, perform this step
now. If you have already assigned an image, HiFusion allows you to replace
the image. If you only intend to assign or replace an image, you leave the
SysOID and the product name unchanged. If you do not intend to replace the
image, skip to the relevant step.
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To change the SysOID and replace the image, you proceed as follows:

* Open the Device tab.

The Device tab displays the identification and images, the SNMP
access parameters, and the protocols of your device.

« Select the row to edit in Identification and Images table.
* Click Edit.

HiFusion opens the Device identification dialog.
» Change the SysOID.

* You can use any MIB variable for additional device identification,
however, using sysDescr.0 is recommended. Marking the Additional
device identification checkbox activates the following fields:

o MIB Variable
o Instance
o Value

> VVendor
Use the following steps to assign or replace an image:

* Click on the image.
HiFusion opens the Select image window.
» Navigate to the image of your choose.
+ Select the image.
* Click Select.

HiFusion displays the file name of the new image next to Image in the
Device identification dialog.

The last work step completes the process and enters the changes in the
PSM project.
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+ Click OK.

HiFusion displays your changes in the table.

Deleting the SysOID

To delete an entry from the table, you proceed as follows:

* Select the row.
* Click Delete.

HiFusion deletes the entry from the list.

Define properties

HiFusion allows you to assign multiple properties to every PSM. In turn, you
assign to every property a MIB variable, which you then configure according to
your requirements.

The prerequisite for completing the work steps in this chapter is that you have
carried out the work steps described in the previous chapters.

Create or remove a property

When you create a PSM in HiFusion, the program displays the discovered
properties device tree (left side panel) of the Properties tab. You can add a
property to the PSM project as long as the associated MIB is available in the
same project.

To create a new property, you proceed as follows:
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* Open the Properties tab.
* Right-click a property or folder in the property tree.
» Select New property from the drop-down list.
HiFusion opens the Input window.
* Enter the name of the property in the New property field.
* Click OK.

HiFusion creates the new property as a sub-property in the device
tree.

After you create the new property, you can configure the PSM to display a
specific attribute in the Devices tab of Industrial HiVision.

To have the PSM display the desired attribute in Industrial HiVision, you
proceed as follows:

* Select the new property in the property tree.
* In the Property type field, mark the Bind to checkbox.

« Select the desired attribute from the Bind to drop-down list. You can
select from the following attributes:

> chassis number
o serial number
o firmware version
> MAC Address

o Configuration Signature

Note: You can specify only 1 attribute per property.

Optional: to select an image for the property, you proceed as follows:
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« Select the property that you want to edit in the device tree.

* In the Properties type frame, next to the Image text field, click
Select.

 Navigate to the folder containing your image.
+ Select the image.

The window displays a larger image allowing you to verify that you
selected the proper image.

* Click Select.

HiFusion displays the file name of the image in the Image field.
To remove a property, you proceed as follows:

* Right-click a property or folder in the device tree.
» Select Remove from the drop-down menu.

HiFusion opens the Remove message window.
* Click Yes.

HiFusion deletes the property from the device tree.

Available Features

In addition to the information imported into the MIBs tab, your PSM can
contain other information about the device. The Features frame of the

Properties tab allows you to select what device information your PSM
contains.

Note: Verify that the MIB values are correct for your PSM after MIB
importation.
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The Standard MultiConfig™ Dialogs Feature

After you create and import a PSM into Industrial HiVision, Industrial
HiVision allows you to specify the basic parameters. Basic parameters are,
System Name, System Location, and System Contact information.

The Standard MultiConfig™ dialogs feature allows you to include additional
dialogs in the PSM. When you activate the feature, the PSM includes the
following dialogs and properties.

» Switching > Global dialog
o Aging Time
» Switching > Multicast > GMRP dialog
> GMRP
» Switching > VLANs > Table dialog
> VLAN ID
> VLAN name
> GVRP
* Redundancy > Rapid Spanning Tree dialog
> Version
o Priority
> Hello Time
o Forward Delay
o Maximum Age
> Tx Hold Count
» Diagnostics > Status Configuration > Global dialog
o Authentication Trap

* Port > Port Configuration > Manual configuration dialog
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* Port > Port Configuration > Automatic configuration dialog
> Autonegotiation
* Port > Port Prioritization dialog
° Priority
* Port > Rapid Spanning Tree dialog
o Stp Active
° Port Path Cost
o Port Priority
o Admin Edge Port
> Auto Edge Port
* Port > VLANSs > Settings dialog
o Port VLAN ID
> GVRP
o Ingress Filtering
o Acceptable Frame Types
Note: If you create a new PSM in HiFusion and activate the Standard
MultiConfig™ Dialogs feature, then the dialogs are displayed in Industrial

HiVision after you import the PSM. This way you can configure other third
party devices using the same PSM.

Add a MIB variable to a property

In order for the PSM to display information associated with the property in
Industrial HiVision, the PSM searches the device for the MIB variable and
retrieves the information contained in the device.

To create a MIB variable for the new property, you proceed as follows:
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« Select the property that you want to edit in the device tree.
HiFusion displays the name and the token for the property.

* In the Properties type frame, next to the MIB Variable text field, click
Select.

HiFusion opens the MIB variable selector dialog.

* In the search field you enter the name of the MIB variable, part of the
name, or a search term.

* Double-click the row in the table.

HiFusion displays the name of the selected MIB variable in the
Properties type frame, MIB variable text field.

Reconfigure MIB variables

In order to tailor MIB variables to your requirements, HiFusion allows you to
reconfigure and change the content in the MIB variables.

The following options are available to you:

« convert the values of a MIB variable,
* create mapping,

« create status configuration.

Additionally, HiFusion allows you to perform many other settings on the
Properties tab.

Note: The selection in the Data type field restricts or expands your options
for the following input fields in the Properties tab. Industrial HiVision
proposes a data type for the selection of a MIB variable. You only change
the data type if you know that the variable has another data type.
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Convert figures

HiFusion allows you to convert values linearly (y = a x x + b). An example of
such an operation is the conversion from °C to °F.

This example defines the values for temperature conversion:

*Factor=a=1.8
» Offset = b = +32
* Value in the agent = x, for example, 50 °C

* Value in HiFusion =y

When you enter the values in the equation, y = 1.8 x 50 + 32 = 122,
Industrial HiVision returns the value output: 122 °F.

Create mapping

Some values defined in the MIB variable are numerical. In order to create a
meaningful output of the values HiFusion allows you to map the output to a
word.

This is an example of mapping using the ifAdminStatus variable:

* Output from the agent =1
Meaning = up

* Output from the agent = 2
Meaning = down

* Output from the agent =3
Meaning = testing

The mapping assigns the meaning to the numeric value.
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Note: If you have loaded the relevant MIB for the MIB variable, Industrial
HiVision creates the mapping automatically for MIB variables of the Enum

type.

Create status configuration

When you select the data type option, HiFusion allows you to specify a
particular status configuration. The status configuration allows you to specify
parameter condition monitoring.

The following list displays which data type HiFusion associates with which
status configuration:

« String: comparison with a reference text.

* Integer: comparison with upper and lower thresholds.

* Float: comparison with upper and lower thresholds.

* Enumeration: a status can be assigned to every possible value.
* MAC Address: comparison with a reference text.

* IP Address: comparison with a reference text.

The following list describes the procedure for the status configuration of an
integer data type:

» Mark the Advanced settings checkbox.
» Mark the Status configuration checkbox.
+ Click Edit.
HiFusion opens the Status configuration dialog.
* In Threshold 1: enter 10.
* In Threshold 2: enter 40.

* Using the drop-down menu next to the Value Below threshold 1:
text field, select Error.
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* Using the drop-down menu next to the Value Below threshold 2:
text field, select Warning.

* Using the drop-down menu next to the Value Below threshold 3:
text field, select OK.

* Click OK.

You return to the Properties tab.

Now when Industrial HiVision monitors the property, it displays the icon
background in the various colors depending on the actual value in the
device.

Save a PSM project

Undoing changes to the PSM project can sometimes be difficult, or cause a lot
of work. For this reason, save the project often.

HiFusion gives you the following options to save a PSM project:

» Save as

» Save

Note: If you only generate the PSM you no longer have the option of editing
the PSM. If you save the PSM project you still have this option. Similarly,
anyone to whom the PSM project is available can edit the PSM project. You
can save the project by generating a PSM. HiFusion saves the project with
the correct file name and the version number appended. Start with a version
number of 001, and increment the version number after every save, so that
you can go back to a previous version. Reserve 100 for the final version.

Save as

The Save as option allows you to save your project in a specific location.
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* When saving the project for the first time, click File > Save as.

HiFusion opens the Select location for saving window allowing you
to navigate to a particular location and save your project.

* When subsequently saving the project, click File > Save CTRL + S.

Saves your PSM project in the previously selected location.

Save

When you save your PSM project for the first time, HiFusion follows the same
procedure as for Save as. Otherwise, Save (Ctrl+S) saves your PSM project
in the last location used.

* Click File > Save (CTRL + ).

You have saved your PSM project.

Create translations (optional)

The Traps tab displays the SNMP traps that HiFusion imported when you
loaded the project load. The imported traps contain the English descriptions
for the traps as seen in the Translations tab. HiFusion allows you to change
the English descriptions and create descriptions for the other languages.

The prerequisite for editing the descriptions is that you have carried out the
steps described in the previous chapters.

To create a description or descriptions for the various languages, you proceed
as follows:

* Open the Translations tab.

» To edit descriptions for a single language or multiple languages, in the
right-side panel, mark the Use checkbox for each required language.

HiFusion creates a column in the table for each language selected.

« Select the row with the description that you want to translate.
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+ Click Edit.
* Fill each empty field with the trap description.
+ Click Save.
HiFusion displays your description in the table.

Note: Fill in every empty field. Otherwise, HiFusion detects a warning and
displays a message, and HiFusion aborts the PSM creation.

Check and test the PSM

After you enter the necessary information to create a basic PSM, the next step
is to check the PSM to verify that the required information is indeed present in
the PSM. HiFusion detects and displays any mistakes or missing information.

After creating a PSM, HiFusion allows you to verify the contents of PSM
project with the following options:

* Check PSM
* Test PSM

The prerequisite for checking the PSM project is that you have carried out the
steps described in the previous chapters.

Checking the PSM

HiFusion checks whether you have filled the mandatory fields. HiFusion
also checks whether the values entered fulfill the specifications for example,
no spaces in the PSM name. You get feedback from the program in the
Errors and Warnings window. The window displays the detected missing
information or mistakes found during the check. Furthermore, HiFusion
automatically checks the PSM before creating a PSM project.

The message window displays information about the following detected error
conditions:
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» the severity of the error or warning,
+ the location of the error or warning,

« the reason for the error or warning.

HiFusion allows you to check the PSM at any time. When saving the PSM,
HiFusion automatically performs a check.

To check the PSM, you proceed as follows:

+ Click PSM > Check PSM.

HiFusion opens a message window which displays the results of the
check.

* When HiFusion displays the message window No errors or warnings
found, click OK. The PSM project is ready for testing.

« If HiFusion displays the Errors and Warnings window, change the
entries accordingly and recheck the PSM.

Testing the PSM

For the testing the PSM project, HiFusion starts a test environment similar to
Industrial HiVision. HiFusion loads the PSM into this test environment.

The following options are available to test the PSM:
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« Virtual test environment

HiFusion accesses data stored in the PSM project and simulates the
Industrial HiVision program:

o Internal agent: the agent simulated by HiFusion only supports
SNMPv1. This means the SNMPv3 always displays the agent
as unreachable.

Furthermore, the MIB of the simulated agent is a snapshot, the
MIB values are static.

o Custom agent dump: allows you to test a MIB dump of a
device from the same family.

* Directly on the device

When the device that the PSM represents is available in the network,
HiFusion allows you to enter the IP address of the device so that you
can test the PSM directly on the device.

Test PSM with the internal agent
To test the PSM with the internal agent, you proceed as follows:
* Click PSM > Test PSM.
HiFusion opens the Test PSM window.
« Verify that the Virtual device radio button is active (default: active).

« Verify that the Internal agent radio button is active (default: active).
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* Click Test.

HiFusion opens the Loadi ng test kernel message, and checks
your PSM. After HiFusion completes the check, the Kernel dialog
opens. The dialog displays your properties in the same position on
the device tree as when you created them. At this time note the IP
address and SNMP Port number. You use the information later when
importing the PSM into Industrial HiVision.

* Click Close.

HiFusion returns you to the program window.

Test PSM with an external agent

To test the PSM on an actual device, you proceed as follows:

* Click PSM > Test PSM.
HiFusion opens the Test PSM dialog.
* Click the IP of real device radio button.
HiFusion activates the IP address text field.
* Enter the IP address of the relevant device.
* Optional: Click Port and enter a port number.
* Click Test.

HiFusion opens the Loadi ng test kernel message, and checks
your PSM. After HiFusion completes the check, the Kernel dialog
opens. The dialog displays your properties in the same position on
the device tree as when you created them. At this time note the IP
address and SNMP Port number. You use the information later when
importing the PSM into Industrial HiVision.

* Click Close.

You return to the program window.
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HiFusion retrieves the values displayed in the Kernel dialog directly from
the device. To change the values in the Kernel dialog, you can change any
value in the device and conduct a Rescan.

Generating a PSM

Generating a PSM allows you to incorporate the device into the Industrial
HiVision network management system. Whenever Industrial HiVision
discovers the relevant device, Industrial HiVision uses the PSM to display the
device information.

The prerequisite for generating the PSM is that you have carried out the steps
described in the previous chapter.

To generate a PSM, you proceed as follows:

 Click PSM > Generate PSM.

HiFusion checks the PSM and returns an error message if a field has
been filled incorrectly.

HiFusion opens the Generator Settings window.

* Optional: To only create the PSM, remove the mark from the Save PSM
project checkbox.

* Optional: Select a path for the location to which the program saves the
PSM project.

The file is saved as a zip file. It is strongly recommended that you do
not change the file name. The digits at the end of the file name are the
digits you entered as the PSM version number.

+ Select a path to which the program saves the PSM.

It is strongly recommended that you do not change the file name, as
Industrial HiVision uses this naming format and file extension.

Generator for Product-Specific Modules (PSM)
Release - 05/2026

62



5. Creating a PSM

« Click Generate.

HiFusion opens the Message window. You receive a message stating
that HiFusion has successfully created the PSM.

* Click OK.

You return to the program.

Change an existing PSM

HiFusion allows you to change existing PSMs so that you can create different
PSMs for other devices.

The prerequisite for changing an existing PSM is that you have a PSM, and
the required MIBs saved locally.

To change an existing PSM project, perform the following steps:

« If you already have the HiFusion program open, then click File > Open.
Otherwise, open the HiFusion program, click Open an existing PSM.
HiFusion opens the Open PSM project window

» Navigate to your existing PSM project.

* Click Open.

You see the various entries on the various tabs.

« Edit the PSM project according to your requirements.

Make MultiConfig™ dialogs for PSMs

The MultiConfig™ tab allows you to make a MultiConfig™ dialog that
HiFusion saves in the PSM. If your PSM includes the MultiConfig™ dialog,
then you can use MultiConfig™ to configure several devices at the same
time.
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Create or remove a MultiConfig™ dialog

HiFusion allows you to change and remove the MultiConfig™ dialogs when
your device changes.

Note: The port configurations do not work for devices with modules.

To define a new dialog in the MultiConfig™ tree for a PSM you previously
defined, proceed as follows:

« To create a new property node for devices, in the Configuration tree,
right-click the Device settings object. To create a new property node
for ports, right-click the Port object.

* Click the New Property option.
 Enter the name of the dialog.
* Click the OK button.

After you click the OK button, HiFusion opens the dialog.

« To configure the new property, click the Add config button.

* In the first blank text field, enter a label name for the property.
HiFusion automatically generates and adds the token in the
Translations tab.

* In the second blank text field, enter the MIB variable for the property.

Optional: To select a MIB variable from the MIB variable selector, click
the Select button.

* Select the property type from the drop down list:
o Integer
° String
> Boolean
o Option
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* Click the Select button.
HiFusion opens the MIB variable selector dialog.

o In the Search field, you enter the name of the MIB variable,
part of the name, or a search term.

o Double-click the row in the table.

HiFusion displays the name of the selected MIB variable in the MIB
variable text field.

To remove a property from the MultiConfig™ tree, proceed as follows:

* Right-click the dialog that you want to remove in the Configuration
tree.

« Click the Remove button.

HiFusion deletes the entry from the MultiConfig™ tree.

Change the dialog icon

When you select a representative image for every property, this increases
the recognizability in HiFusion. Images in HiFusion have the dimensions
36 px x 36 px.

To assign or replace an image, use the following steps:
* Right-click the property.
« Select the Edit Image option.
HiFusion opens the Select dialog.
* Navigate to the image you wish to change.

* Highlight the image, click the Select button.
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Import a dialog from another PSM

To import a dialog from another PSM to the MultiConfig™ tree, proceed as
follows:

* Right-click the Device settings object or Port object in the
Configuration tree.

* Click the PSM Import button.
HiFusion opens the Open dialog.
» Navigate to the property that you wish to import.
« Select the property, click the Open button.
* Navigate to the property that you wish to import.

« Select the property, click the Open button.

Generator for Product-Specific Modules (PSM)
Release - 05/2026

66



Index

M
MIB Variable
48

S

System requirements
7

Generator for Product-Specific Modules (PSM)
Release - 05/2026

67



Further support

Technical questions

For technical questions, please contact any Belden dealer in your area or
Belden directly.

You find the addresses of our partners on the Internet at www.belden.com.

For technical support, visit my.belden.com. This site also includes a free of
charge knowledge base and a software download section.

Technical Documents

The current manuals and operating instructions for Belden products are
available at doc.hirschmann.com.

Customer Innovation Center

The Customer Innovation Center is ahead of its competitors on three counts
with its complete range of innovative services:

 Consulting incorporates comprehensive technical advice, from system
evaluation through network planning to project planning.

* Training offers you an introduction to the basics, product briefing
and user training with certification. You find the training courses on
technology and products currently available at www.belden.com/
solutions/customer-innovation-center.

» Support ranges from the first installation through the standby service to
maintenance concepts.

With the Customer Innovation Center, you decide against any compromise in
any case. Our client-customized package leaves you free to choose the service
components you want to use.
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